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Introduction: 

Welcome to the Fire Incident Mapping Tools for ArcGIS. 
This User’s Guide was developed to describe how to utilize the Fire Incident 
Mapping Tools (FIMT) version 1.83 Build 3 in ArcGIS.  The document is divided 
into functional sections designed to instruct users in operating the fire mapping 
tools in ArcMap as they apply to the workflow typical at an Incident command. 
The best way to learn ArcMap and the fire mapping tools are to try them yourself. 
This User’s Guide includes step-by-step tutorial sections (highlighted in light 
gray) and a sample tutorial dataset for instructional purposes. The sample 
dataset is a modified version of actual data collected from the Colgate fire that 
occurred near Nevada City, California. A majority of the incident data has been 
fabricated for use in a tutorial work flow. 

Fire Incident Mapping Tools for ArcGIS 
The Fire Incident Mapping Tools are an ArcGIS extension. The extension is a 
persistent extension. In other words, there is no requirement to turn it on or off.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The FIMT Fire Mapping Tools are accessed through the FIMT toolbar, which is 
added to ArcMap using the Customize dialog. To add custom controls and 
toolbars: 

1. Click the Tools menu, and then click Customize.  
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2. Click the Toolbars tab if it is not already selected. 
3. Click the check box to the left of the FIMT Fire Mapping Tools toolbar 

name.  
4. Click Close.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

The FIMT Fire Mapping Tools toolbar is loaded into the ArcMap GUI (Graphical 
User Interface). The toolbar can be docked to the ArcMap GUI in any desired 
location. 

 
The FIMT Fire Mapping Tools toolbar is composed of icons that represent 
both buttons and tools. For the purpose of this document, buttons perform 
an immediate task. Tools require interaction from the user either in the 
form of cursor control in the map view or in a popup dialog. The buttons 
contained on the FIMT toolbar are activated based on the current settings 
in the ArcMap document. The current editing environment, selected sets, 
and the entity type of selected features all affect which buttons are 
enabled. (Note: Each tool is described in detail in Appendix I). The FIMT 
Fire Mapping Tools toolbar is divided into groups separated by vertical 
bars. The tools located in each group are described in Appendix I; the 
following sections describe a more functional use of the tools. 
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Incident Management and Information 
 
There are several tools that allow you to manage the information contained in 
your Incident personal geodatabase. This management allows the user to tailor 
the FIMT map environment to support the local requirements of the Incident and 
to support routine GIS tasks during the Incident.         

Creating a New Incident 
Each Incident created by the Fire Incident Management tools is managed as a 
personal geodatabase (PGDB) stored on your file system (See Appendix III for 
detailed information on the structure of the Incident PGDB). At the start of a new 
Incident, you will create a new Incident and corresponding personal 
geodatabase.  

 
To create a new Incident, click the New Incident button        on the FIMT toolbar. 
A popup dialog allows you to enter the information needed to create a new 
Incident. 

 
The current release of the Fire Incident Mapping Tools (Version 1.82 Build 3) 
supports the management of multiple Incidents from the same ArcMap 
document. Each Incident is contained in its own personal geodatabase and is 
accessed in ArcMap using a concept of an active Incident. Only one Incident can 
be active at a time and a tool is provided to switch active Incidents. The switch 
can only occur when there is no current editing session taking place.  At the point 
one or more individual fire Incidents converge into a single event, they can be 
combined into a single Incident using standard editing tools. Tools for copying 
features from one or more sources into an Incident are available in the FIMT 
toolbar and are explained in Appendix I. 

 
Each Incident consists of the following information: 
 
Incident Name: The Incident (fire) name can consist of any text string and is 
usually already assigned to an Incident. 
 
Incident Number: The Incident number may be pre-assigned from the IMSR 
database located at NIFC in Boise, Idaho. 
 
Magnetic Declination: Magnetic declination is sometimes referred to as 
magnetic variation or magnetic compass correction. It is the angle through which 
a magnetic compass bearing must be rotated in order to point to the true bearing. 
The FIMT New Incident dialog contains web links to web pages maintained for 
regions including the United States, Canada, and Australia1. The NOAA National 
Geophysical Data Center (NGDC) manages the United States web page. Users 

                                            
1 Other regions can be added by inserting records to the “DeclinationSites” table in the 
template geodatabase. See Appendix II for details on the Incident PGDB data model. 
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who have Internet access can use these web pages to determine the correct 
declination value for the Incident location. Otherwise, magnetic declination can 
be located on most standard map series. Note: The magnetic declination is 
provided for reference purposes only; it does not affect the performance of the 
FIMT Fire Mapping Tools. 

 
Coordinate Format: Each Incident has a default coordinate format that 
establishes how latitude/longitude values are displayed by the tools. These 
values can be changed at any time. The options include: 

Decimal Degree (37.46842 N:: 107.71703 W) 
Degree Decimal Minutes (37 28.105 N:: 107 43.022 W)  
Degrees Minutes Seconds (37 28 6.33 N:: 107 43 1.30 W) 

 
Spatial Reference: Every new Incident must be assigned a spatial reference. 
The spatial reference defines the coordinate system (map projection information) 
and the x/y domain of the data contained in your Incident. You should always set 
the coordinate system for new Incidents. The FIMT tool will automatically 
calculate the x/y domain based on the coordinate system you select from the 
default list provided by ArcGIS. This calculation is pre-established by the tool and 
is based on maintaining adequate precision for your data as well as allowing for a 
bounding box that is large enough to accommodate the data you will be 
managing. Advanced users can manually calculate and set a specific x/y domain.  
However, be aware that this cannot be changed once the Incident PGDB is 
created. Incorrect x/y domain values may prevent data from being inserted into 
the Incident. The easiest way to set this is to import a coordinate system from an 
existing dataset that covers the area where the incident occurs or is likely to 
cover. 
 
The installation package used to install the FIMT extension includes an ESRI 
developer sample called “CalcLoadingParams.exe”. This executable can be used 
to help you calculate a suitable X, Y domain for your incident if you are using a 
coordinate system that is not included in the default list provided by ArcGIS. (See 
Appendix III).  

 
Geodatabase: Each new Incident is written to a new personal geodatabase 
(PGDB) stored in the location selected by the user. Use the browse button to 
select the path and enter the name of the PGDB to create.          

Opening an Existing Incident 
You can open an existing Incident at any time. Since all of the information 
needed to manage an Incident is stored in the personal geodatabase, the FIMT 
Fire Mapping Tools can reestablish their own environment. Use the “Open 
Incident” button on the FIMT toolbar. Navigate to the Incident personal 
geodatabase you want to open and then click Open on the browser dialog. The 
Incident grouped layer will be added to your map document. The selected 
incident will be made the active incident. 
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The FIMT Fire Mapping Tools allow you to manage more than one Incident in an 
ArcMap document. The “Open Incident” button will add the selected Incident 
personal geodatabase to the existing map document along with any other 
Incident that was already opened. 
 
You can also open any existing ArcMap document (.MXD) that has the FIMT 
grouped layer in its table of contents without the need to use the Open FIMT 
Incident button. If you have added other supporting feature classes, images, or 
tables to your map document, you will want to save and reopen your ArcMap 
document to maintain the reference to those layers. 

Switch Incidents 
If you have loaded more than one Incident into the current map document, you 
can switch between active Incidents using the “Switch Incident” button. The 
Switch Incident button can only be used when there is no current edit session. If 
you are editing features, the Switch Incident button will be disabled. Saving and 
stopping editing will reactivate the Switch Incident button. 

Getting Incident Information  
At any time during the use of the Fire Incident Mapping Tools, you can access 
the Incident information you entered when you created the Incident PGDB. The 
“Incident Information” button gives the user access to the Incident name, 
number and other information. The dialog can also be used to modify the same 
information if necessary.   

Moving Data to a New Data Frame   
ArcMap supports the use of multiple data frames in an ArcMap document. 
Multiple data frames can be used to represent your Incident with different 
background source information. For example, you may need to display both 
digital orthophotography (DOQ) and Digital Raster Graph (USGS/FS single 
edition quadrangle maps) in your Incident maps. Rather than toggling between 
the two images in the ArcMap table of contents, you can establish separate data 
frames for each image source.  

 
You create a new data frame using the ArcMap Insert > Data Frame menu 
option.  You can select an existing data frame and make it active by right clicking 
on its name in the ArcMap table of contents and selecting Activate from the 
context menu. You use the “Copy Incident Layers to Data Frame” button to 
add the Incident group layer for the active incident to the new (active) data frame.  
You can now modify any map property in each data frame independently and 
thus have several alternate views of your Incident in the same map document. 
Each data frame can be added to a map layout to develop a variety of map 
products. 
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Changing Symbology 
There are several options for setting the map symbology used by the 
FIMT Fire Mapping Tools. These options include a toggle between standard color 
and standard black and white symbols, changing the size of point markers, lines, 
and text labels, and changing between bold and normal text. Use the Incident 
Symbols button to modify the FIMT symbology. The Symbols and Labels dialog 
contains a checklist of layers that can be modified. All other operations on the 
dialog will operated on the selected set of layers. Buttons on the dialog control 
the sizing of symbols for lines, points, and text. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Symbol Color: can be changed using the buttons at the top of the dialog to 
switch between standardized color and black/white symbols. The switch of 
symbol colors will reset the symbology to the standard default values. Any 
customization of the ISC layers performed by the user will be lost. The color 
switch applies to all the layers in the active incident; the checklist at the bottom of 
the dialog does not apply to the color switch. 

Using Latitude/Longitude Values 
Latitude and longitude values are frequently used to reference locations on the 
ground during an Incident. You will receive information from GPS data collection 
as well as manual map interpretation that you will need to process into your 
Incident database. You will also need to provide latitude/longitude values to 
personnel involved in the Incident. The Fire Incident Mapping Tools provide 
several functions for accessing and updating information based on latitude and 
longitude. See the section on Managing Data Elements, Point Locations for 
information on using latitude/longitude values to create and modify Incident point 
features.    
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Obtaining Latitude/Longitude   
You can easily get latitude/longitude values from your 
Incident database by using the Get Latitude/Longitude button on the FIMT 
toolbar. The button returns latitude/longitude values for any location clicked in the 
map view. The format of the coordinate values returned can be represented in 
Decimal Degrees, Degrees Decimal Minutes, and Degrees Minutes Seconds.  

Managing Data Elements 
The core functionality of the Fire Incident Mapping Tools is to provide the ability 
to create, modify, and display features of a wildfire Incident command. These 
features include fire lines, fire points, fire perimeters, assignment breaks, and 
perimeter sector lines, as well as tracking the history of features as they evolve 
over time. The following sections of this document outline the process for 
managing FIMT features. 

Editing an Incident   
The tools used for managing data elements in the FIMT toolbar are activated 
only during an active edit session. Click on the Edit Incident button to begin 
editing. If you have added data to your ArcMap document from outside the 
Incident PGDB, you must select the Incident PGDB as your target database.  
Once you are in an active edit session, you will see that many of the tools on the 
FIMT toolbar have become enabled. You can also activate an editing session 
using ArcMap functionality; you must have the Editor toolbar added to your 
ArcMap GUI. From the Editor pull–down menu on the Editor Toolbar, click “Start 
Editing” to activate the editing environment.  

Selected Set 
In addition to activating the FIMT Fire Mapping Tools during an edit session, 
several of the FIMT Fire Mapping Tools are only enabled when there is a 
selected set of features from a particular feature class contained in the FIMT 
geodatabase. You can use any standard ArcMap selection tool or method for 
creating a selected set.  

Selectable Layer(s) 
The selectable layer(s) can be controlled from several locations on the ArcMap 
GUI. The menu option “Selection” > “Set Selectable Layers” opens a dialog that 
is used to select the layers that can be selected. This is very important when 
editing certain FIMT fire features, as you will frequently be switching the 
selectable layers. The ArcMap Table of contents can also be changed to include 
a “Selection” tab that gives the user easy access to control the selectable 
layer(s). Click “Options” on the “Tools” menu to open the Options menu. On the 
TOC (Table of Contents) tab, check the Selection box on. This will add the 
“Selection” tab to the bottom of the Table of Contents.  
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ArcMap Tip: Remember to turn off the select ability all of the History feature 
classes since there is very little need to select them. 

Deleting Fire line and Fire Point Features 
During any ArcMap edit session, fire line and fire point Incident features can 
easily be deleted using standard ArcMap functionality. Select the features you 
want to delete and then click the Delete key on the keyboard.  

Deleting Fire Perimeters 
During the process of creating and maintaining an Incident database, it may be 
necessary to delete and replace your fire perimeter(s). The FIMT fire mapping 
tools maintain a relationship between the FirePolygon, PerimeterSector, and 
AssignmentBreak feature classes. This relationship is maintained during a delete 
operation. If a fire perimeter polygon is deleted, the FIMT tools will automatically 
delete the related objects. In the process of removing a fire perimeter, if you need 
to maintain the other objects, you must copy them to another feature class prior 
to deleting the fire polygon. 
 
ArcMap Tip: The FIMT fire mapping tool uses a relationship between the 
FirePolygon ObjectID field and the PerimeterSector and AssignmentBreak 
feature classes PerimeterID field. If there are a number of associated 
PerimeterSector and AssignmentBreak features, you can use this relationship to 
select all of the features for deletion.  Prior to deleting the FirePolygon polygon, 
identify the ObjectID for the selected polygon(s). You can then use this value to 
query the PerimeterSector and AssignmentBreak feature classes to select the 
associated features that also need deleting. 

FIMT Features 
The FIMT geodatabase consists of two Feature datasets each containing five 
feature classes.  The following table shows the contents of the Incident 
geodatabase. 
 
Feature 
Dataset 

Feature Class Geometry Use 

Incident AssignmentBreak Point Point location indicating changes in Sector, 
Division, Branch and zone. 
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Incident Fire Line Line Fire line locations 
Incident FirePolygon Polygon Actual fire perimeter polygons 
Incident Fire Point Point Misc. point locations  
Incident PerimeterSector Line Lines matching fire perimeter used to indicate 

changes in assignment for fire perimeter. 
History Hist_AssignmentBreak Point Assignment break features snapshot by time/date 
History Hist_Fire Line Line Fire line features snapshot by time/date 
History Hist_FirePolygon Polygon Fire Perimeter(s) snapshot by time/date 
History Hist_Fire Point Point Fire point features snapshot by time/date 
History Hist_PerimeterSector Line Linear features used to indicate changes in 

assignment for fire perimeter features snapshot by 
time/date 

 

Fire Perimeters 
Fire perimeters are polygon features stored in the FirePolygon feature class. The 
FIMT Fire Mapping tools maintain additional feature classes that store features 
needed to symbolize, label and track portions of the fire boundary 

Perimeter Assignment Breaks (Zone, Division, Branch and Sector) 
Zone, Division, Branch and Sector assignment breaks provide the administrative 
mechanism to divide the fire perimeter into separate, attributed line segments. 
Under normal operating procedures, this is a hierarchical system where Sectors 
are nested inside of Divisions and they are nested inside of Branches.  Many 
times Divisions and Branches are the only assignments used on and Incident. 
Zones and Sectors are provided for those Organizations that require the 
additional levels of the hierarchy. The FIMT Fire Mapping Tools allow the user to 
manage zones, divisions, branches and sectors through a line feature class 
named PerimeterSector and a point feature class named AssignmentBreak.  

 
The geometry of the PerimeterSector line feature class is designed to 
automatically follow (snap to) the geometry of the FirePolygon polygon feature 
class. The FIMT Fire Mapping Tools performs feature snapping between the 
FirePolygon and the PerimeterSector feature class when the FirePolygon is 
edited. No editing of the shape of the lines in the PerimeterSector feature class 
can be performed. Any attempted reshaping of the PerimeterSector lines will be 
snapped back to follow the fire perimeter. The only direct editing of the 
PerimeterSector feature class allowed is splitting the lines into separate 
segments that can be attributed with their corresponding attribute values. The 
splitting of the PerimeterSector feature class is performed using the Split 
Assignment Line tool.   

 
Update Perimeter Assignment Breaks  
The AssignmentBreak point feature class has special symbology that indicates 
the change in assignment represented by special bracketed symbols. These 
point symbols are automatically generated based on the assignment attributes 
given to the lines in the PerimeterSector feature class.  The symbology of the 
break points as well as updating any required changes in the geometry are 
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updated using the “Update Perimeter Assignment Breaks” button. The 
following symbology is used based on the level of assignment break change in 
attributes. 

 
 
 
 
 
 
 
 

 

Creating a New Incident Perimeter  
You can create a fire perimeter using any methodology for data entry available in 
ArcMap. These methods may include heads up digitizing from a reference image, 
digitizing from paper source maps, importing data from GPS collection, and 
importing other coverages or shapefiles into ArcMap. Polygons from these 
sources are copied into the FirePolygon feature class using the “Copy to 
Perimeter Layer” button.  The FirePolygon feature class is populated and 
attributed using tools in the FIMT toolbar. When creating a fire perimeter in a new 
Incident PGDB there are several steps that must be followed: 
 
Step 1A – “Copy to Perimeter layer”  
(Using existing polygons): Use the button to move any set of selected 
polygons into the FirePolygon feature class. If this is a new (empty) Incident 
PGDB, the FirePolygon feature class will be empty. During the copy to perimeter 
process, both the FirePolygon feature class will be populated and the matching 
lines in the PerimeterSector feature class will also be created. 
 
Step 1B – (Using existing polylines ArcInfo or ArcEditor): You can create a 
FirePolygon from line segments that connect or cross to form a closed area. This 
process is only available with ArcEditor and ArcInfo licenses (ArcView license 
users can use the Trace tool to trace linear features to create a polygon). Use the 
Topology toolbar to access the “Construct Features” tool. This step also requires 
the use of a target scratch polygon feature class to receive the constructed 
polygon (See section “Creating a scratch Feature Class”). NOTE: Do not use the 
actual FirePolygon feature class for the target feature class when using the 
Construct Features tool; you must create the polygon into a scratch feature class 
before it can be copied into the FirePolygon feature class.  
 

1. Make sure the Topology tool bar is added to the ArcMap GUI. 
2. Select the existing line segments that form a closed polygon from any 

available source. 
3. Set the Target Feature class on the Editor Toolbar to your scratch polygon 

feature class. 
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4. Set the edit task to “Create New Feature”. 
5. Click the “Construct Features” tool on the topology toolbar, accept the 

default cluster tolerance and click “OK”. This will create a new polygon in 
the scratch polygon feature class. 

6. Set the selectable layers to include the scratch polygon feature class, and 
then select the newly created polygon.  

7. Click the “Copy to Fire Perimeter” button to copy the new polygon into 
the FirePolygon feature class. This will also create the corresponding 
polylines in the PerimeterSector feature class. 

 
Step 1C – (Using existing polylines ArcView): You cannot create a 
FirePolygon from line segments that connect or cross to form a closed area when 
using an ArcView ArcGIS license. The topology toolbar “Create features” tool is 
disabled with an ArcView license. You can, however, use the ArcGIS Trace tool 
to trace selected lines that close to form a polygon area.  The FirePolygon 
feature class should not be used as the target feature class for creating the 
polygon. You should create a scratch polygon feature class in the Incident PGDB 
that can be used to capture the new polygon. The following steps can be used to 
create a fire perimeter polygon by tracing existing line segments. Note: This 
process is described in detail in the section: “Tutorial: Adding a Fire Perimeter- 
Advanced Editing” 
 

1. Set the selectable layer to the source of the lines being traced 
2. Select all the line segments that you need to trace. 
3. Set the Target on the Editor Toolbar to a scratch polygon feature class 

and set the Task to Create New Feature. 
4. Select the Trace tool from the Editor Toolbar. 
5. Click in any location on the selected line segments and begin tracing. 
6. Trace along the first line segment until you reach an intersection with 

another selected line or you reach the endpoint of the line currently being 
traced. 

7. Left Click (once) to stop tracing at the intersection, then Left Click again 
in a location in the next line segment to trace. This stops tracing of one 
line segment and begins tracing again on the next segment. 

8. Continue until the entire area has been traced, and then Double Click to 
end the trace process and complete the closed polygon. 
 

Step 1D - Creating polygon from no existing vector source:  
Use the “Create Fire Perimeter” tool to manually draw any new fire perimeters 
using whatever source of information you have available. Make note that when 
you select this tool, the edit task is automatically set to “Create Fire Perimeter” 
and the target feature class is set to the FirePolygon feature class.  
 
The remaining steps outline the process for completing a new fire polygon and 
adding the attributes and assignment breaks. 
 
Step 2: Creating Assignment Break geometry:  
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Once you actually create a FirePolygon, all of the associated assignment values 
(Sector, Division, Branch, and Zone) contained in the PerimeterSector feature 
class will be set to “Unassigned”. The line segment representing the fire polygon 
assignments in the PerimeterSector feature class will consist of a single line that 
closes to match the fire polygon. If the new FirePolygon will be associated with 
more than one assignment break, you must first split the PerimeterSector line at 
the appropriate locations.  
 
“Split Assignment Line”  
Use the “Split Assignment Line” tool on the FIMT Toolbar to perform this task. 
You will need to split the PerimeterSector line at each location that corresponds 
to your administrative assignment of Zone, Branch, Division, and Sector.  The 
“Split Assignment Tool” will re-draw the split PerimeterSector line segments with 
a temporary graphic displaying each side of the split in blue and green colors. A 
dialog is them presented that allows you to set the assignment attributes to each 
side of the split. (Note: These categories are all optional; you can allow the Zone 
and Sector values to remain unassigned if these are not used at your incident). 
 
ArcMap Tip: Do not use the ArcMap “Merge” tool to un-split PerimeterSector 
lines, as this will create unpredictable results. You can use the ArcMap “Split 
Tool” to split a PerimeterSector tool, however; you will have to manually set the 
Unit assignment using the Assign to Unit tool. 
 
 
Step 3: Assigning to Unit:  
Use the “Assign to Unit” tool to attribute the line segments with the correct 
Zone, Branch, Division, and Sector label.  You should make certain that all lines 
have been assigned the correct assignment values. During the Assignment break 
process, you may inadvertently create an additional line segment between the 
last assignment break and the point where the original FirePolygon closed. 
 
Step 4: Update Perimeter Assignment Breaks:  
Use the “Update Perimeter Assignment Breaks” button to generate 
AssignmentBreak point symbols at the connection point between multiple 
PerimeterSector lines. This tool will insert the appropriate point symbol into the 
AssignmentBreak point feature class. The tool will automatically un-split (merge) 
all connecting PerimeterSector lines that have identical assignment attributes. 
 

Merging/Splitting Assignment Breaks 
The assignment breaks in the PerimeterSector feature class can be modified at 
any time. New assignments can be created and removed by updating the 
assignment attributes for the lines requiring modification. 

 
Removing Assignment Breaks: Update the associated attribute values for 
Zone, Branch, Division, and Sector in the PerimeterSector Feature class. Then, 
use the “Update Perimeter Assignment Breaks” button to remove Assignment 
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breaks if the attribute values in the PerimeterSector feature class are the same 
on both sides of the Assignment break. 
 
Create Assignment Break: Use the “Split Assignment Line” tool to split a 
selected PerimeterSector line in the location of the new Assignment break. Then, 
use the “Assign to Unit” button to assign different Assignment break attributes 
to the lines on each side of the split. The “Update Perimeter Assignment 
Breaks” button then can be used to update the Assignment breaks and create 
the new point feature at the location of the split. 

 

Fire Lines 
Fire Lines are linear features used to represent a variety of linear features in your 
Incident personal geodatabase. There are eighteen (18) fire line types that are 
maintained in a coded value domain in your Incident PGDB (See Appendix II for 
a diagram representing the fire line domain).  

Creating 
Fire lines can be created using several methods. Data input can include heads-
up digitizing from a raster backdrop (DOQ, DRG) or by moving selected features 
from another data source into the Fire Line feature class.  
 
Create Fire Lines:  
This tool allows you to draw directly into the Fire Lines feature class using the 
mouse. The tool prompts the user for fire line attributes once a fire line is 
entered. Using the standard “create Feature” process in ArcMap will not prompt 
for these attributes and should be avoided to eliminate the possible of missed 
attributes.  
 
Vertices along a line are entered using the left mouse button. You can control 
existing vertices along a line by clicking the right mouse button while the cursor is 
positioned over a vertex. You can access additional coordinate input methods 
and other vertex commands using the right mouse button while the cursor is 
positioned away from existing vertices. You complete (Finish Sketch) the line by 
double-clicking the left mouse button. Once the line input is complete, a popup 
dialog is displayed that allows you to specify the fire line type and division 
designation if desired. 

 
Copy to Fire Lines:   
This tool allows you to copy any selected linear feature(s) from any source into 
the Fire Line feature class. You will frequently receive input in the form of 
shapefiles or coverages that have been collected using a variety of different 
processes. Any of these sources can be used to input data into Fire Line. The 
copied lines will not be attributed, and will default to an Unknown fire line type. 
After using the “Copy to Fire Lines tool, you must then set the fire line type and 
unit assignment appropriately.  If Firelines are imported from another incident 
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PGDB or have any fields in common with the fireline class, these attributes will 
also be imported. 

Modifying Fire Line Geometry 
You will frequently be required to update or modify FIMT features based on the 
condition of the Incident and operations that are taking place daily on the ground. 
Several FIMT Tools support these modification tasks. 
 
Split Fire Lines:  
This tool allows you to split a single selected line into two parts. The “Split Fire 
Lines” tool changes the cursor to a knife icon that is used to draw a line across a 
single existing fire line. The crossed line is divided into two parts. A dialog is 
opened that allows you to set the line type and division assignment for both parts 
of the split line segment. Only a single line segment can be split during a single 
split operation. Drawing across multiple line segments will produce an error 
message. 
 
Join Fire Lines:  
This tool allows you to merge two separate line segments into a single line. The 
two lines must be selected, and the end points must be connected (coincident). 
Use the standard ArcMap tools to select the features you want to join. Clicking 
the “Join Fire Lines” tool will open a dialog that allows you to select the line type 
and assign the division to the single line segment created from the two selected 
fire lines. 
 
Modify Fire Line Attributes:   
During the lifespan of the Incident database, you will periodically need to change 
the line type designation for your fire lines. This operation is accomplished using 
the “Change Fire Line Type” tool. You can use any ArcMap selection method to 
select a single fire line. Clicking the “Change Fire Line Type” button will activate 
the dialog that allows you to select the fire line type and to assign a division 
designation. 

 

Point Locations 
Point locations are used to indicate single point locations on the ground. The 
FIMT Fire Mapping Tools provide functionality to add, modify, attribute and label 
point features. The points are stored in the Fire Point feature class in the Incident 
PGDB. 

Creating 
Point locations can be added from several sources including heads up digitizing 
using a reference image, digitized from paper maps, input from a GPS device or 
other source coverages and shapefiles, and added using latitude/longitude 
values. The add point functionality in the FIMT Fire Mapping Tools provides a 
dialog for setting the point type and point type specific information such as Name 

 19



and Date for particular point types. The spot fire point type also includes a 
direction to indicate the direction of spread.   

 
Create New Fire Point:  
This tool adds point locations to the Fire Point feature class based on user input. 
You simply click on the location for the new point feature. A dropdown list is 
displayed containing a list of valid point types. Additional attribute input boxes will 
change based on the point type selected.  

 
Create New Fire Point Latitude/Longitude Coordinate Input:  
This tool adds point locations to the Fire Point feature class based on the 
latitude/longitude values entered by the user. The input dialog accepts coordinate 
values in Decimal Degrees, Degree Decimal Minutes, and Degrees Minutes 
Seconds. After entering a coordinate, a dropdown list is displayed containing a 
list of point types. Additional attribute input boxes will change based on the point 
type selected. 

Modifying 
Move Fire Point: Latitude/Longitude Coordinate 
Point feature attributes and location (x/y coordinates) can be modified using the 
FIMT Fire Incident Mapping Tools. Points can be selected and moved using the 
ArcMap Edit tool to select and drag and drop features in the map view.  Entering 
a new latitude/longitude value using the “Move Fire Point: Latitude/Longitude 
Coordinate” Input tool can also be used to modify point locations. You use this 
tool to move a selected point to a new location based on known latitude/longitude 
values. The tool accepts coordinate input in Decimal Degrees, Degree Decimal 
Minutes, and Degrees Minutes Seconds. 

Importing from Other Source 
 
Copy Features to Fire Points   
Any valid point data source can be used to input points into the Fire Point feature 
class. Use the “Copy Features to Fire Points” button to move the selected set 
of points into the Fire Point feature class. The selected points will be copied to 
the Fire Point feature class and given the default miscellaneous point type. After 
a set of selected points are moved into the Fire Point feature class, you can set 
the point type using the “Change Point Information” tool. 

Changing Point Types 
You can change the point type and corresponding additional attribute values of a 
single selected point in the Fire Points feature class using the “Change Point 
Information” button. A dialog will open that contains a list of fire point types and 
their associated attributes. 
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Creating a “scratch” Feature Class (ArcEditor, ArcInfo) 
There may be occasions while editing an Incident that you need feature classes 
to store temporary features before they are moved into your Incident feature 
classes. These temporary feature classes (line and polygon) must be added to 
the Incident geodatabase so they can be used while in a current FIMT edit 
session. For example, if you are using ArcEditor or ArcInfo, you can convert a 
collection of lines into a polygon using the “Construct Features” tool found on the 
Topology tool bar. The “Convert Features” button requires a target polygon 
feature class to receive the created polygon. The FirePolygon feature class found 
in the Incident geodatabase has several custom behaviors that make it a poor 
target feature class to use for the Convert Features tool. The scratch polygon 
feature class can be used as the target feature class and then the newly created 
polygon can be move to the FirePolygon feature class using standard FIMT tools. 
To create these scratch feature classes, use the following steps.  

 
 Save any existing edits and stop editing if a current edit session is active 

in ArcMap. 
 Open ArcCatalog, using the catalog tree and navigate to your FIMT 

geodatabase. 
 Right click the Incident Geodatabase, click New > Feature Class 

 
 
 
 
 
 
 
 
 
 
 
 
 

 Enter a name in the name field (i.e. “scratch_line”, “scratch_poly”) 
 Click “Next”, Click “Next” again. 
 Click on the “Shape” column; verify that the Geometry Type is correct for the 

feature class you are creating (Line, or Polygon). 
 Click on the Ellipse button (“…”) to the right of the Spatial Reference Field 

property to set the spatial reference (See Green Arrow on graphic below).  
 Use the import button to navigate to the Incident geodatabase, select the 

FirePolygon feature class in order to set the same coordinate system. 
 Click “Finish” to create the feature class (see below). 

 
Note: If the geodatabase is to be shipped to someone for their display, these 
scratch feature class(es) should be removed. 
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Incident History 
One of the most significant features contained in the FIMT Fire Mapping Tools 
and the Incident PGDB is the ability to create snapshots of the current Incident 
information and store it into history layers. There are five history feature classes 
contained in the Incident PGDB that match the feature classes in the Incident 
feature dataset. These include Hist_AssignmentBreak, Hist_Fireline Line, 
Hist_FirePolygon, Hist_Fireline Point, and Hist_PerimeterSector.  

 
All of the features that are copied to the history feature classes are attributed with 
a date and time stamp. This attribute allows any number of uses that require 
information about the condition of the Incident at a particular time. During an 
Incident command, the GIS staff editing an Incident database should make 
periodic copies to the history feature classes. This should be done at lease once 
per day. 

Moving Incident Elements to History Layers 
 

Copy to History  
The “Copy to History” tool opens a dialog that allows you to select from Fire 
Lines, Fire Perimeters, and Fire Points to snapshot into the history feature 
classes. Selecting the Fire Perimeter option will actually snapshot FirePolygon, 
Assignment Breaks, and PerimeterSector lines to their respective history feature 
class. Based on the frequency of change, you should decide how often historical 
snapshots should be made.  
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Generating Reports 
Fire line, fire perimeter, and fire perimeter change reports can be generated 
based on the assignment attributes on the PerimeterSector lines and the Fire 
Line feature classes. The reporting tools in the FIMT toolbar contain the 
functionality that copies the contents of the report to the Windows clipboard. You 
can then use the paste functionality to add the report text to any text editor/word 
processor, or you can paste the report text into the ArcMap layout view.  

Fire Line Report 
The fire line report contains a summary of each fire line type by feet, miles, and 
chains.   

Perimeter Report   
The perimeter report summarizes the fire perimeter branch and division as well 
as summarizing the fire line features by division. This report gives you a 
complete list of all line types by division. 

Perimeter Change Report   
The perimeter change report uses the information saved in the history feature 
classes to produce a report of changes in perimeter area over the lifespan of the 
Incident. For each date in the perimeter history, a record will be reported showing 
the actual area and the change in area. 

Output to Text Editor 
The copy button on the popup report dialog box utilizes the Windows clipboard to 
store the text from either a perimeter or Fire Line report. You can paste the 
copied text into any text editor that supports Windows cut and paste functionality. 

Labeling Incident Features 
All of the Incident features can be labeled using the “Label Multiple Fields” tool 
on the FIMT toolbar. This tool includes a pull down list of all the FIMT feature 
classes and a series of check boxes next to each attribute item found in the 
selected feature class. Checking the radio button next to one or more attribute 
columns will add that column to the custom label properties for the selected 
feature class. A label string is constructed and added to the map display. The 
option to include the attribute column name in the label string is also available. 
This is particularly useful for labeling PerimeterSector divisions and branches.   
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The “Label Multiple Fields” tool actually builds a label expression that can be 
accessed and edited using the feature class Layer properties dialog under the 
“Label” tab.  
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FIMT Fire Mapping Tools Tutorials: 

Tutorial: Installing the Data 
 
A sample set of data has been created from the Colgate fire. The actual data 
contained in the Tutorial data set has been created to demonstrate steps you 
might actually perform during an incident. This is not real data and may not 
represent the actual procedures you follow.  
 
Using Windows Explorer, navigate to the tutorial CD and run the setup.exe. Store 
the training data in any working directory you wish and make note of it since you 
will use this directory for the remaining tutorial steps. 
 
Tutorial narrative: The text shown in green italic font represents the tutorial 
narrative. These narratives are intended to emulate an incident scenario. These 
steps are strictly hypothetical and are not intended to represent the actual steps 
used at a real incident command. 
 

Tutorial: Setting up a New Incident 
Create a new map document, set map properties, and then load the FIMT Fire 
Mapping Tools. 
 
Open ArcMap. Set the properties for your map document. Click the File menu, 
and then click Map Properties. Fill in the appropriate information on the Map 
Properties dialog. 
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Click the Data Source Options… button to set your ArcMap document to use 
relative paths. This is especially important if you are going to be distributing you 
map document and data to other computers. Storing your data relative to the 
map document will eliminate the need to set the data source on other computers.  
 
 
 
 
 
 
 
 
1. Click the Tools Menu, and then click Customize. 
2. Check on the “Fire Incident Mapping Tool” from the Toolbar tab. 
3. Dock the FIMT Toolbar to the ArcMap GUI in any location you like. 
4. Click the Create Incident         tool on the FIMT Toolbar. 
5. For the purposes of the tutorial, enter the information shown on the 

following graphic.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Click the Set Spatial Reference button to select a spatial reference. This 

button will open the standard ArcGIS spatial reference properties menu.   
7. Click the import… button.  
 
Note: For the purpose of the tutorial, you will be using a custom “Teale Albers” 
projection commonly used in the western U.S. (California, Oregon and 
Washington). The actual coordinate system you use will depend on the location 
of your incident, the size of the incident, and the coordinate system of available 
of supporting data such as digital orthophotography and digital raster graphics. 
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8. Use the Spatial Reference Properties dialog to navigate to the tutorial data 

directory. Select the “082904_1500_per_colgate.shp” shapefile to import 
the spatial reference from the data provided.  

 
Note: Selecting a defined projection using the Select… button will automatically 
set the x/y domain. The FIMT tool automatically defines the x/y domain for all 
standard coordinate systems.   
 
9. Click OK. 
10. Make sure you specify a working directory for the Incident Personal 

geodatabase. Name the Incident PGDB “Missionary_Ridge.mxd”. 
11. Click OK on the FIMT New Incident dialog.  A new personal geodatabase 

will be created and saved in the directory specified. A grouped layer named 
Missionary_Ridge::CO-SJF-26804 will be added to the ArcMap table of 
contents. The grouped layer contains all of the feature classes used by the 
FIMT Fire Mapping Tools. 

12. Save your ArcMap document to your working directory. Name it 
“Missionary_Ridge.mxd”. 

13. Close ArcMap. 

Tutorial: Opening an Existing Incident  
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Open ArcMap. Make sure the FIMT Fire Mapping Tools are turned on. 
14. Click the Open FIMT Incident         button on the FIMT toolbar. 
15. Using the browser, navigate to the FIMT_Tutorial.mdb personal 

geodatabase saved in the Creating a New Incident tutorial step.  Click 
Open. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Optional: 
Alternatively, you could open the map document, which already contains your 
Incident personal geodatabase. 
16. Open ArcMap. 
17. Open the FIMT_Tutorial.mxd ArcMap document located in your working 

directory.  

Tutorial: Adding Reference Data to your Incident 
The data provided with the FIMT tutorial includes several USGS Digital Raster 
Graphic (DRG) images as well as a low resolution Digital Orthophoto mosaic. 
You will use these images to provide reference data for your FIMT Incident. First 
you will create an additional data frame to your map document, and then you will 
add the DRG images to one data frame and the DOQ image to the other. You will 
be able to activate either data frame to view your Incident with a DRG or 
orthophoto background. 
 
1. Right-click the Layers data frame in the ArcMap table of contents, then click 

Properties. 
2. Using the General tab, name this data frame “DRG”. 
3. Click “OK”. 
4. Click the Insert menu, and then click Data Frame. 
5. Right-click the new data frame in the table of contents and select Properties 

from the context menu. 
6. Using the General tab, name this data frame “DOQ”. 
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7. Using the “Coordinate System,” tab, set the coordinate system by importing 
from an existing source. Navigate to the tutorial data directory. Select the 
“082904_1500_per_colgate.shp” shapefile to import the spatial reference 
from the data provided 

8. Click “OK” to close the data frame properties dialog box. 
9. Right-click the DRG data frame, then click Activate. This data frame should 

be in bold text on the table of contents indicating that it is the active data 
frame. 

10. Click the ArcMap Add Data button,           and browse to images directory 
contained in the FIMT Tutorial install directory. 

11. Add All 6 tiff images that are prefixed with “q39121” to the active data 
frame. 

12. Select  all 6 images in the ArcMap Table of Contents (TOC) as shown in the 
graphic below: 

 
 
 
 
 
 
 
 
13. Right click the selected images, and then select “Group” from the context 

menu. This will create a group layer containing all six images. The group 
layer will facilitate turning the images on and off easier. 

14. Right click the group layer, and then click “Properties”. 
15. Using the General tab, rename the group layer “Digital Raster Graphics”.  
16. Right-click “Digital Raster Graphics” group layer in the TOC, then click 

Zoom to Layer. 
17. Right-click the DOQ data frame, then click Activate. 
18. The DOQ data frame should be active. This data frame should not contain 

any layers. 
19. Click the Copy FIMT Layers to Dataframe button         on the FIMT 

toolbar. This button will copy all of the FIMT Incident layers to the data 
frame.  

 
Note: The “Copy FIMT to Dataframe” tool makes a copy of each FIMT feature 
class from the active incident database into the active Dataframe. Since this is a 
copy of the active incident database, editing can take place in either data frame. 
 
20. Click the ArcMap Add Data button,         and browse to FIMT Tutorial data 

directory. 
21. Add the DOQ.tif image to the active data frame. Ignore the warning about 

the missing spatial reference if it appears. 
22. Right click the DOQ image in the table of contents, then click Zoom to 

Layer. 
23. Save your map document. 
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Tutorial: Creating the initial Incident data: 
Tutorial narrative: In the initial phases of this Incident, it is August 29, 2004 and 
you are assigned to the FIMT Tutorial Incident. At 20:00, the Situation Unit 
Leader informs you that he will need the IAP map for the morning IAP packet. 
Your IAP will be for the day shift on August 30th and it will be distributed at the 6 
a.m. morning briefing.  
 
You have received the initial perimeter, contained in a shapefile, from the infrared 
interpreter. The shapefile is located in the FIMT Tutorial installation directory. The 
file is named 082904_1500_per_colgate.shp. 
 
You have also received a GPS shapefile from a field crew. The shapefile 
contains waypoint information. You will use the table definitions for each 
waypoint to build FIMT points and to assign branch/division breaks to the fire 
polygon. The shapefile is located in the FIMT Tutorial installation directory. The 
file is named 082904_1500_wayp_colgate.shp. 
 
24. Click the DRG data frame and click Activate if it is not the current active 

data frame. 
25. Click the Add Data button,         and browse to your FIMT Tutorial install 

directory. 
26. Add the 082904_1500_per_colgate.shp shapefile to the active data frame. 
27. Start the editing environment on the Incident personal geodatabase. Click 

the “Edit Incident” button.    
 
Note: You can also start editing by selecting “Start Editing” from the Editor 
Toolbar > Editor Pull down menu. Several of the FIMT Fire Mapping Tools that 
were previously grayed out should now be enabled.   
 
Next you will select the source perimeter and copy it to the FirePolygon feature 
class.  
 
ArcMap Tip: from this point on in the editing process, you will be frequently 
switching selected sets. You can add the selection tab to the Table of Contents 
to make this task easier. Open the Options dialog under the Tools > Options 
menu. Activate the TOC tab, and then check the Selection check box in the TOC 
Tab Options control panel. Click OK to close the Options dialog. 
 
28. Set the selectable layer to 082904_1500_per_colgate.shp.  
29. Use the Select Features tool        to select the perimeter contained in the 

selectable layer. 
30. Click the Copy to Perimeter Layer button         on the FIMT toolbar. 
31. Right-click the perimeter1.shp layer, then click Remove. 
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Examine the contents of the FirePolygon feature class. Notice it now contains the 
polygon that was selected from the 082904_1500_per_colgate shapefile. This 
process can be used to move any selected polygon from any valid polygon 
vector data source into the FirePolygon feature class. 
Also examine the contents of the PerimeterSector feature class. You will notice 
that this feature class now contains a line that matches the shape of the fire 
perimeter. The PerimeterSector feature class contains linear features that are 
used for attributing assignment breaks in relation to the fire perimeter.  

Tutorial: Adding Initial Assignment breaks. 
Tutorial narrative: You will use the attributed WayPoints to create assignment 
breaks on the PerimeterSector feature class in the FIMT Tutorial Incident 
geodatabase. Your Situation Unit Leader has informed you that the FirePerimeter 
has been assigned the following Branch/Divisions. 
 
  Branch I – Div A, B, C, D 
  Branch II – Div E, F, G, H 
  Branch III – Div T, U, V 
  Branch IV – Div X, W, Y, Z 
 
The 082904_1500_wayp_colgate shapefile contains two attribute columns that 
you will use to construct your IAP map. The WAYPOINT column contains a label 
text string. The TYPE field contains the WAYPOINT category. You will label the 
WAYPOINT layer so you can see the Division breaks. You will use the TYPE 
field to create a definition query to display only the Division/Branch break points 
to simplify the map display. 
 
1. Click the Add Data button,         and browse to your FIMT Tutorial install 

directory. 
2. Add the 082904_1500_wayp_colgate.shp shapefile to the active data 

frame. 
3. Right click the 082904_1500_wayp_colgate.shp, and then click 

“Properties…” 
4. In the Labels tab on the Layers Properties dialog, check the “Label 

Features in this Layer” check box. Verify or set the Label Field to the 
WAYPOINT attribute column. 

5. In the Definition Query Tab, use the Query builder to construct the 
following query string: "TYPE" = 'DivBrk' 

6. Click ‘OK’ to accept the Layer Properties. 
7. Click the “Split Assignment Line” button to activate the Split tool.  
 
Note: the cursor should change to a knife icon. You use the split tool by clicking 

to draw a line across the location of the split. 
 
Once you create the split, the PerimeterSector line will be temporarily re-drawn in 
Green and Blue indicating both sides of the split.  The Split Assignment Line 
dialog box will open. Use the “Assign Blue Line…” and “Assign Green Line…” 
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buttons to assign the Sector, Branch, Division, and Zone attributes to the color 
coded line. The Sector and Zone values can remain “unassigned” if those values 
are not used at your incident. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Click the Assign Blue Line…” button to open the “Assign to Units” dialog 

box. Follow the graphic example below and assign the Blue line to Branch 
“I” and Division “A”. 

9. Repeat the process for the Green line, assigning it the values: Branch “I” 
and Division “B” 

10. Click OK to complete the Split Assignment process. 
 
 
 
 
 
 
 
 
 
 
Note: Once the Split Assignment process is completed, the associated 
AssignmentBreak point symbol will be added to the map display. 
 
11. Repeat the Split Assignment Line process for all of the Division break 

waypoints located around the fire polygon. Make certain you assign the 
appropriate Branch value for each Assignment Break using the list on the 
previous page. 

Tutorial: Annotating Initial Assignment breaks 
Once you have correctly created the Assignment breaks by subdividing and 
attributing the PerimeterSector feature class, you need to add division and 
branch labels to your IAP map. There are several methods that you can use to 
create labels on your map. The FIMT tool bar contains the “Label Multiple Fields” 
button that can generate labels from several attribute columns as well as include 
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the field name in the labels. In many cases, attribute labels are adequate for map 
generation.  
 
In this tutorial step, you will use to “Label Multiple Fields” tool to generate labels 
that you will then convert into geodatabase annotation. You can then edit the 
annotation to create better placed text on your map. 
 
1. Click the “Label Multiple Fields” on the FIMT toolbar.  
2. Select the PerimeterSector feature class in the “Select a Layer…” pull down 

menu. 
3. Check the DivisionID field in the “Check the fields to use for labeling…” 

scrolling list. 
4. Check on the “Include field names in labels?” check box. 
5. Click “OK” to create the labels.  
 
Note: you should now see the DivisionID: labels oriented parallel to the 
PerimeterSector lines. 
 
Next, you will edit the PerimeterSector Label expression to abbreviate the 
Division label to “Div” and then convert the labels to geodatabase annotation. 
 
6. Right click the PerimeterSector feature class in the TOC, and then click 

“Properties…” 
7. On the Labels tab, click the “Expression…” button. 
8. In the Expression text box, edit the existing expression to contain the 

following: "Div" &[DivisionID]  
9. Click the “Verify” button to make sure your expression syntax is correct. 
10. Click OK to accept the expression, and then click OK to close the Layer 

Properties dialog. 
11. Right click the PerimeterSector feature class in the TOC, then click “Convert 

Labels to Annotation…” 
12. Check off the “Display overlapping labels in the overflow window” check box. 
13. Select the “In Database Option” radio button in the “annotation Storage 

Options” control panel. 
14. Click the Browse button to the right of the “Output Annotation Feature Class” 

text box. 
15. In the “Output Annotation Feature Class” dialog, navigate to your 

FIMT_Tutorial geodatabase.  Enter “DivisionAnno” in the Annotation Feature 
Class: text box. Leave the Dataset: textbox empty. 

16. Click OK on the “Output Annotation Feature Class” dialog and then click OK 
on the “Convert Labels to Annotation” dialog. 

 
The DivisionAnno feature class should now be added to your map display. Next, 
you will orientate the Annotation horizontal, and then position the individual text 
to the outside of the fire polygon. 
 
17. Click the “Select Element” tool on the ArcMap Tools toolbar.  

 33



18. Use the Select element tool to select ALL the annotation on the map display. 
The selected annotation should be highlighted with a dashed line. 

19. Position the cursor over any of the selected annotations, right click, and then 
select “Properties…” from the context menu. 

20. Enter 0 in the Angle textbox, and then click OK. 
 
All of the selected Annotations should now be rotated to a horizontal position. 
 
21. Using the “Select Element” tool select each annotation one at a time and drag 

it to a location outside the fire polygon in a position between each assignment 
break symbol. 

 
Using steps 1-21 above, repeat this process to create annotation for the Branch 
assignments. Modify the label text to read “Branch I”. Position these annotations 
outside the fire polygon between the Branch assignment break symbols.  
 
Once you have repeated these steps for the Branch annotation, you map should 
appear similar to the graphic below. (The DRG/DOQ images have been turned 
off for clarity): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tutorial: Adding Fire lines from the Fire Polygon 
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Tutorial Narrative: At the 20:00 meeting with your Situation Unit Leader, you 
were informed that the following fire line information has been gathered: 

  Active fire: Div DE break to Div UV break 
   Dozer Line: Div UV break to Div WX break 
  Completed Line: All remaining line 
 
The concept Fire perimeter in the FIMT geodatabase is actually composed of 
several feature classes including; FirePolygon, PerimeterSector, and 
AssignmentBreak. The FirePolygon is the actual area contained by the 
perimeter. PerimeterSector is a line feature class that is automatically snapped to 
the FirePolygon. This linear feature class is used to manage the Assignment 
break attributes on lines that match the FirePolygon. This is necessary because 
the geodatabase cannot store linear attributes on a polygon feature class 
(FirePolygon). AssignmentBreak is a point feature class used to symbolize 
changes in assignment breaks.  
 
You can use the PerimeterSector features to copy these line segments into the 
FireLine feature class to create fire lines that follow or conform to the 
FirePolygon.  
 
1. Right click the PerimeterSector feature class, then select “Selection” > “Select 

All” 
2. Click the “Copy to FireLines” button on the FIMT Toolbar.  
3. Click off the PerimeterSector feature class in the TOC. 
4. Verify that the FireLine feature class in visible. 
5. On the TOC Selection tab, make the FireLine feature class the only 

selectable layer. 
6. Use the “Select Features” tool to select the line segments from Div DE break 

to Div UV break. You should have six (6) lines selected. 
7. Click the “Attributes” button to open the “Attributes” dialog. 
8. In the left pane of the “Attributes” dialog, click on the top most “FireLine” 

group. The right panel should contain a list of Properties (attribute columns) 
with no visible attribute values. 

9. Click to the right of the “FLType” property to activate the Fire Line Type 
domain. 

10. Select “Uncontrolled Fire Edge” from the pull down list of domain values. 
 
Note: These lines were copied from the PerimeterSector feature class so there 
are six selected Fire lines of the same type. You can use the Merge menu option 
on the Editor Tool bar to merge the selected Firelines into a single line to make 
future management of the fireline easier. 
 
Note: When using the Attribute dialog, you can set the attributes for an entire 
selected set by selecting the top of the selected set in the left panel. You will not 
actual see the attribute values in the right panel. They will however be set and 
visible in the individual records.  
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Next, you will use the FIMT “Change Fireline” tool to set the fire line type to 
“Completed Dozer line” for the Lines from Div UV break to Div WX break. 
 
11. Select the two lines represented between the breaks described above. 
12. Use the Editor > Merge operation to merge the selected lines into a single line 

segment. Make certain the FireLine feature class is the only selectable layer. 
13. Click the “Change Fireline” tool on the FIMT toolbar.  
Note: The current version of the FIMT tools only supports changing a single 
selected line. In the next release, you will be able to have multiple line segments 
selected. 
14. Select “Completed Dozer Line” from the Pull down list of Fire line types. 
Note: You can also use the “Change Fireline” tool to assign Branch/Division 
values to fire lines as well as add metadata about the fire line. You should 
experiment with these additional buttons to become familiar with their operation. 
15. Click OK to apply the change to the fireline attributes. 
16. Repeat steps 11-15 for the remaining unassigned Firelines. Set the Fire line 

type to “Completed Line”. 

Tutorial: Adding Fire Points from an existing Source 
Tutorial Narrative: The 082904_1500_wayp_colgate shapefile contains 
additional way points that need to be added to your FIMT Tutorial database as a 
variety of different fire point types.  
 
1. Right click the 082904_1500_wayp_colgate shapefile in the TOC, and then 

click “Properties…” 
2. On the “Definition Query” tab, click the “Query Builder…” button. 
3. On the Query Builder dialog, click the clear button.  
4. Using any method, create a query string as follows: "TYPE" <> 'DivBrk' (This 

query will query out all points except the Division Break points you have 
already used. 

5. Click the “Verify” button to make sure your query syntax is correct. 
 
Note: your 082904_1500_wayp_colgate layer should still be labeled with the 
WayPoint field. If not, set the layer properties to label with this field. 
 
6. Right click the 082904_1500_wayp_colgate layer in the TOC, and then click 

Select > Select All 
7. Click the “Copy to Firepoints” button on the FIMT toolbar to copy the selected 

points into the FirePoint feature class. 
8. Make certain the FirePoint feature class is turned on. 
Note:  once you copy the selected points into the FirePoint feature class, you 
should see the new fire points displayed as red question marks indicating the fire 
point type is unknown. You must now set the firepoint type from unknown to the 
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correct fire point type based on the WayPoint label in the source shape file. 
Using the “Change FirePoint” tool on the FIMT toolbar, you will set the attribute 
values one at a time. 
9. On the TOC Selection TAB, set the FirePoint as the selectable layer. 
10. Select one of the Firepoints displaying the Unknown point type. (Red 

question mark). 
11. Click the “Change Firepoint” tool on the FIMT toolbar. 
 
 Tutorial Narrative:  The Waypoint shapefile contains the following Fire Point 
types: 
 DP = Drop point, enter the “DP” and the number in the Name field 
 Staging = Staging Area, enter the name in the Name field 
 ICP = Incident Command Post, enter “ICP” in the Name field 
 Base = Incident Base, enter “Base” in the name field 
   Origin = Fire Origin, set Name field blank 
 
12. Repeat steps 10-11 for all of the remaining Unknown fire points.  
 
Note: The “Copy to Firepoint” tool automatically adds the text string “Not Set” in 
the name field for all copied points. Make sure to set the Name field blank for all 
fire points that do not have a name. This will prevent the string “Not Set” from 
displaying in labels using the Name field.  
 
Note: The FirePoint feature class is added by default below the other FIMT 
feature classes in the TOC. You can move this feature class to the top by 
dragging it in the Display tab of the TOC. 
 
13. Click the “Label Multiple Fields” tool on the FIMT toolbar to label the fire 

points. Set the layer to FirePoint, and check on the PointName field for 
labeling. Click OK to draw the label. 

 
Note: The Firepoint labels may conflict with other features on the map making 
them difficult to read. You can follow the steps above to create another 
Annotation feature class containing FirePoint text.  
 
Once you have completed the tutorial steps to this point, you map should appear 
similar to the graphic on the following page: 
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Tutorial: Creating Historical Snapshots 
The FIMT Fire Mapping Tools allow you to create a series of historical snapshots 
of your Incident data over the life cycle of the Incident. You should decide at the 
beginning of the Incident what the frequency should be for making historical 
copies of your Incident. 
 
1. Click the Copy to History button.  
2. Using the dialog, select which layers you want copied to history. For the 

tutorial, leave all of the choices selected. 
 
Tutorial Narrative: The first day of your assignment to this incident began on 
August 29th, 2004. Your first snapshot to history should be dated with this date 
and occurred at 22:30. 
 
 
 
 
 
 
 

 38 



 
 
 
Note: examine the five feature classes associated with the history feature 
dataset in the ArcMap TOC. You will find that for each feature class in the 
Incident feature data set, there is a matching history feature class. 
 

Tutorial: Modifying the Incident 
 
Tutorial Narrative: It is now the second day of your assignment to the 
FIMT_Tutorial incident.  You have received updated Fire Perimeter information in 
a shapefile.  You have also received an updated waypoint shapefile containing 
new assignment breaks where the fire has spread. Infrared interpretation from 
the previous night has indicated that there are two large unburned areas inside 
the fire perimeter that contain valuable residential properties. Your Situation Unit 
Leader has informed you that these unburned areas have been assigned to a 
new Branch (V) and need to be added to the Incident map.  The fire has also 
spread to the northwest. Updated fireline is included in the new shapefile.  
 
You will need to deliver the updated maps for the evening IAP packet for 
distribution at the 18:00 briefing. 

Tutorial: Modifying the Fire Perimeter 
Note: There are several methods that can be used to reshape an existing 
FirePolygon. This tutorial demonstrated only a few valid methods.  It is important 
to remember that the FirePolygon is synchronized with the PerimeterSector 
feature class and the AssignmentBreak feature class through the FIMT 
extension. If you encounter behavior using the FIMT extension that indicated 
these feature classes are no longer synchronizing, you should save your edits 
and map document, exit and then restart ArcMap. 
 
1. Navigate to the Tutorial install directory and add the following shapefiles to 

you map document. 
   083004_1550_update.shp 
   083004_1500_wayp_colgate 
2. Zoom in to an area containing the two perimeter update lines in the NW 

area of the FirePolygon.  
3. On the Editor toolbar, set the Target Layer to “FirePolygon”, and set the 

Task to “Reshape Feature” 
4. Using the Selection tab on the TOC, set the selectable layer to FirePolygon 
5. Select the FirePolygon using the standard Select tool. 
6. Activate the “Sketch Tool” on the Editor Toolbar.  
7. Position the cursor over the updated perimeter line, then Right-click and 

select “Replace Sketch” 
8. With the cursor in the same position, Right-click again and select “Flip”. 
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9. The flip will reverse the location of the End-point of the replacement sketch 
(the Red point). 

10. Right-click once more, select “Finish Sketch” from the context menu. 
 
The FirePolygon will redraw with the added area. The PerimeterSector lines and 

AssignmentBreak points will also adjust with the FirePolygon. 
 
 
 
 
 
 
 
 
 
 

Original 
FirePolygon 

Step 7 Step 8 Step 9

 
11. Repeat these steps for the next FirePolygon update in the same area. 
 
 
 
 
 
 
 
 
 
 
 

Select 
FirePolygon 
Right click – 

 Replace sketch 

Right click – Flip Right click – 
Finish sketch

Completed update 

Tutorial: Modifying the Fire Perimeter, Adding Island Polygons 
Note: The FIMT toolbar contains tools for creating and deleting FirePolygon 
island exclusions. You should always use the FIMT tools to create these 
features. Using ArcMap standard edit tasks will result in unpredictable behavior. 
 
1. Zoom to the center of the existing FirePolygon where there are two update 

polylines. You will use these lines to create the Island polygons. 
2. Click the “Create Island” tool on the FIMT toolbar. 
Note: the Editor Target is automatically set to FirePolygon and the Edit task is 
set to “FIMT Create Island”. Do not attempt to create an island polygon using any 
other combination.  
3. Using the Selection tab on the TOC, set the selectable layer to the 

FirePerimeter, and the 083004_1550_update shapefile. 
4. Select both the FirePolygon and one of the 083004_1550_update polylines 

located in the interior of the FirePolygon. 
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5. Change the Edit tool to the Trace tool. See the graphic below for help on 
locating the “Trace” tool. 

 
 
 
 
6. Click on the selected update line inside the FirePolygon, using the cursor, 

move around the update line, following the line as closely as possible. You 
will see the trace line following your cursor movement.  

7. Continue tracing around the update line until you return to the beginning. 
Double-click to end the trace. 

 
 
 
 
 
 
 
 
 
 

Trace 
direction 

8. Repeat the Create Island process using the second Update polyline. 
 

Tutorial: Modifying the Fire Perimeter, Updating Assignment 
breaks 
The update shapefile 083004_1500_wayp_colgate contains updated division 
break points. Use the skills previous learned to update the Assignment breaks 
where the FirePolygon has expanded in the northwest direction, and add 
assignment breaks to the unburned islands where indicated by a new waypoint. 
Use labels to help you locate and attribute the Branch and Division assignments. 
All of the Islands are assigned to Branch V. 

Tutorial: Generating Fire Line Fire Perimeter Reports  
The FIMT Fire Mapping Tools include the ability to generate reports for fire 
perimeters and for fire lines. These reports can be copied to the Windows 
clipboard and pasted into any text editor and they can be pasted into an ArcMap 
layout for inclusion in a hardcopy map. 
 
1. Click the “Perimeter Report” button . Examine the contents of the 

report. 
2. Click the Copy button on the Perimeter Report and close the dialog. 
3. From the Windows Start menu, click Start > Programs > Accessories > 

WordPad. 
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4. In WordPad, click Edit, and then click Paste. The contents of your report are 
now pasted into the WordPad document. 

 
Next, you will include a report in your ArcMap layout. 
 
5. Click the “Fire Line Report” Button      .  Examine the contents of the 

report. 
6. Click the Copy button on the Fire Line report. 
7. In ArcMap, toggle to the map Layout view.  
8. Click Edit, and then click Paste. 
9. The text from the Fire Line report is now pasted into the map layout. 
10. Double click on the pasted text to activate the text property sheet. 
11. Modify the properties of the text to best fit the report on the map layout. 
12. Save the map document and close ArcMap. 
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Appendix: 

Appendix I: Tool Usage 

Group 1. Incident Tools 
 
 
 

Create Incident 
 

This tool creates a completely new FIMT Incident and its 
corresponding Geodatabase. When you click this button, the following 
dialog will be displayed: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
• Type the name of the Incident into the Incident name field. 

 
• Type the Incident number into the Incident number field.  This can 

be any text string – not just numeric.  
 

• If you know the magnetic declination for the area of the fire, type 
this into the magnetic declination field.  (This information is not 
currently used – it may be used for the mapping tools, to be 
developed later).  If you have an active Internet connection, the 
“GO” button and corresponding region pull down list will take you to 
a web page that will let you determine your magnetic declination.  
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The magnetic declination is not required to operate the FIMT Fire 
Mapping Tools.  

 
• Select the coordinate format you would like to use for entering 

latitude/longitude coordinates for this project.  This will become the 
default coordinate format, used whenever you are asked to enter 
lat/long input.  You can change this later if you want, or you can 
override it on the lat/long input dialogs for one-time exceptions.  

 
• Select the spatial reference you want to use for the Incident 

database.  This is required only because ArcMap needs to know: a) 
How to store the data you are going to create through the 
application, b) How to project raw lat/long and GPS coordinates into 
your Incident database, and c) How to project your Incident data to 
match other data you may have, or to match the spatial reference 
of your ArcMap display.   
 
To set the spatial reference, click the Set Spatial Reference button.  
This will bring up the Spatial Reference Properties dialog (the same 
one as used in ArcCatalog).   From here, you can select a standard 
spatial reference, or define your own. (Note:  When in doubt, use 
the UTM projection for the Incident area).    

 
• Specify the name of your new FIMT database and where it should 

be stored using the Browse button next to the geodatabase name 
field.  

 
• Click OK and the new Incident database will be created for you.  

The standard FIMT Incident layers will be created from this 
database and loaded into your current data frame automatically.   

 

Open Incident
 

This tool lets you browse the file system and open a geodatabase that 
contains Incident data.  Simply select the appropriate geodatabase, 
and the application will load the FIMT layers it contains into your 
current data frame automatically, and you can begin working with the 
Incident tools. 
 
If you load an Incident into a document that already has layers in the 
map, such as background layers or images, the Incident layers will be 
added to those in your active data frame.   
 
If you have loaded one Incident into your document then load another, 
the second Incident becomes the active Incident.  Anything you do 
with the FIMT Fire Mapping Tools will apply only to that Incident.   
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If your map document already contains the layers for an Incident, 
opening the Incident a second time will not create another set of 
layers.  The newly opened Incident will become the active Incident, 
and anything you do with the FIMT Fire Mapping Tools will apply to 
that Incident.   The FIMT Fire Mapping Tools will use the existing 
layers from that Incident.  

Switch Incident 
 
This tool allows you to switch from one Incident to another when more 
than one Incident has been loaded into the current ArcMap document. 
The button is only active when editing is not taking place. You cannot 
switch to a different Incident with an active edit session taking place. 
To switch to a different Incident you must save your edits (if 
appropriate) and then stop editing. 

Edit Incident 
 
This tool starts an ArcMap Edit session for the active incident. You 
can verify the active Incident by using the Incident Information button 
described below. This tool performs the same task as selecting 
“Editor” > “Start Editing” from the standard ArcMap Editor Tool bar.  
To stop editing, you must select “Stop Editing” from the Editor menu 
on the Editor Tool bar. 

 

Incident Information
 
This button displays the FIMT Incident information dialog (the same 
dialog that you used to create the Incident), but only some of the fields 
can be modified: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 45



 
You can change the name, the Incident number, the magnetic 
declination, and the default lat/long coordinate format, but you cannot 
change the spatial reference or the geodatabase file. 

 
 

Copy to History 
 
This button saves a snapshot of the current fire layers into the history 
layers contained in the Incident geodatabase.  Use this tool if you 
want to preserve a record of the Incident including fire lines, fire 
perimeters, and fire points at a particular point in time.   
 
The button is enabled if you are editing the Incident geodatabase, and 
the perimeter layers are present in the active data frame.  When you 
click the button, you will be asked to specify the date and time you 
want to record with the fire perimeter.  The current date and time are 
filled in by default: 
 
  
 
 
 
 
 
 
 
 
 
 
 

 
A date and time stamp is recorded in the history feature classes. 
These values can be used to query the history layer to view previous 
versions of the fire perimeter or other fire layers. 

Copy Incident Layers to Data frame 
 
There may be times when you want to have several data frames 
containing your FIMT Incident layers.  For example, you may want to 
have your Incident layers displayed over two different sets of 
background images. Or, you may want to have one data frame that 
contains an overview of the entire fire area, and another that is 
zoomed in on a particular location. This tool lets you copy the Incident 
layers into the current data frame. To use it: 
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Create a new data frame, using the Insert > Data Frame menu option.  
Or, select an existing data frame and make it active by right clicking 
on its name in the table of contents, and selecting Activate from the 
context menu.  
 
Click the Copy FIMT Layers to Data Frame button.  The Incident 
layers will be added to your active data frame.  
 

Export to Shape file 
 
This tool creates a set of output shapefiles from the active Incident 
database. The user specifies the output directory where the files will 
be written. There is no control over the names of the output shape file 
names.  All of the attribute items that belong to a geodatabase domain 
will be exported with both the domain code and description text as 
matching attribute columns. 

Group 2. Utility Functions 
 
 
 
 

 Auto Update Measures 
 
This command watches in the background and detects when a new 
feature is added or the shape of an existing feature is modified by any 
edit operation (not just the fire tools). The command operates as an 
environment setting and is either on (appears indented) or off 
(appears similar to other buttons). The command scans for certain 
fields on features, and if it finds one of more of the fields, it populates 
it with a specific measurement calculated from the feature’s shape.  
The following table lists the fields it looks for and the measurements 
that are calculated: 
 

Field Name Applies to Contents 
AutoXCoord Points only X-coordinate of point features, in the spatial 

reference of their GDB. 

AutoYCoord Points only Y-coordinate of point features, in the spatial 
reference of their GDB 

AutoLatitude Points only Point feature latitude, calculated by projecting 
point if necessary. Datum is WGS84 

AutoLongitude Points only Point feature longitude, calculated by projecting 
point if necessary. Datum is WGS84  

 47



AutoFeet Lines and 
Polygons 

Length of line or perimeter of polygon in feet.   
Calculated by projecting feature to localized 
equal area projection. 

AutoMeters Lines and 
Polygons 

Length of line or perimeter of polygon, in meters.  
Calculated by projecting feature to localized 
equal area projection. 

AutoAcres Polygons Area of polygon feature in acres; calculated by 
projecting feature to localized equal area 
projection. 

AutoHectares Polygons Area of polygon feature in hectares; calculated 
by projecting to localized equal area projection. 

 
To calculate lengths and areas, the tool constructs a localized equal-
area projection using the center of the feature’s envelope as the 
projection origin. The tool then projects the feature into that coordinate 
system on-the-fly and gets the necessary measurements. This 
process insures consistent values regardless of the source projection. 
The process returns accurate measurements, but because the shapes 
are projected out of their native coordinate system, the returned 
measurements will not match exactly the ones a user would get if they 
take the shape out of the database and get its area, length, or 
perimeter.   
 
The tool will calculate these values for any features (not just FIMT fire 
features) that have the fields that correspond with the feature’s 
geometry type, as listed above. It will calculate values for a subset of 
the fields if they are not all present on a particular feature. (e.g., if the 
perimeter length fields are missing from a polygon feature, it will still 
calculate the areas).  
 
When the tool button is “pressed in”, the tool is monitoring feature 
changes and automatically calculating the measurements.  When it is 
not pressed in, the tool is ignoring all feature changes and will not 
update measures.  When it is reactivated, it will not go back and 
recalculate measures for features that were modified while it was 
inactive.  Users should leave the tool turned on all the time if they’re 
working on a fire Incident, since the reports generated by the fire tools 
use these fields to report lengths and areas.  They can turn the tool off 
if they’re doing non-fire Incident work, a small performance increase 
while editing may be observed when the tool is turned off however, 
performance should not be a determining factor when using the tool.  

Update Fire Names and Numbers 
 
This command button operates in the background controlling the 
population of the Fire Name and Number fields for all newly created 
fire features (fire point, fire lines, and fire perimeters). There are three 
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setting options that control the automatic update of the Incident 
number field.  Clicking on the button opens the following dialog: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The tool allows turning the Auto update on or off. The automatic 
update could affect performance during certain processes so the user 
has the option to turn off the Auto Update feature. The user also has 
the option at any time to run a manual update of the fire name and 
number values. 

FIMT Feature Metadata 
 
This button opens a form that allows the user to enter feature level 
metadata attributes for the selected features. The following form is 
opened: 
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All of the attribute fields that contain a list of valid values appear 
with a pull down list on the form. The remaining fields are free form 
text field. The user must know their local data standards to input the 
appropriate values. 

 

Change FIMT Symbol Properties 
 
This button brings up a dialog that lets you set some overall properties 
of the symbols used for mapping Incident data. The dialog contains 
two buttons that switch between color and black/white symbol sets. 
The symbol color settings will always reset symbol properties to the 
default values for either color choice. Any user defined customizations 
to layer symbol properties will be lost if the color choice is switched. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The dialog also controls resizing marker, line, and label sizes by 
incrementing the size one point larger or smaller. Text labels can also 
be toggled between bold and normal text.  To control symbol size 
properties: 
• Select the appropriate check box to indicate which layer(s) are to 

be changed.  
• Use the “Select All” button to select all of the Incident layers, or the 

“Clear All” button to clear all Incident layers from the list of layers to 
modify. 

• Use the “Larger” or “Smaller” buttons to the left of “Make markers 
one point” text on the form to increment the point marker symbols 
for the selected layers. 
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• Use the “Larger” or “Smaller” buttons to the left of “Make lines one 
point” text on the form to increment the line symbol width for the 
selected layers.  

• Use the “Larger” or “Smaller” buttons to the left of “Make labels one 
point” text on the form to increment the size of text labels for the 
selected layers. 

• Use the “Bold” or “Normal” buttons to the left of “Make text style” 
text on the form to switch text labels between bold and normal text. 

• Click “Close” to close the dialog.  Note:  Changes made using the 
form are applied immediately and can be undone by applying the 
opposite operations. 

Label Multiple Attributes 
 
This command allows users to create simple “stacked” labels using 
any number of fields in an FIMT feature class.  It works directly on the 
label properties of the feature layer, so the user can go into the labels 
dialog and further modify the label format if they wish.  The button 
pops up the following form containing the following features.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select a layer… Allows the user to select the layer to label. Select 
the layer from the dropdown list of layers in the current ArcMap 
document.   

 
 Check the fields to use for Labeling: A list of fields found in the 

layer selected from the Select a layer dropdown list.  Check the 
fields you want to use for the stacked labels.  Each field selected 
will be a separate line in the stack.  

 
 Include field names in labels? Use this check box to include or 

exclude field names in the labels.  If this is checked, the labels will 
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look like “Fieldname = Value”.  If it’s not checked, only the values 
will be shown.  

 
 OK button to keep the settings and closes the form.  Use this 

when you want to modify just one feature class.  
 

 Apply button to create the labels for the selected feature class but 
leaves the form open so you can set up labels for another feature 
class. 

   
 Cancel button to close the form without applying the current 

settings.  Any settings you applied with the “Apply” button will still 
be in effect and will not be undone by the Cancel button.  

 

Assign to Unit 
 

This command button displays a form that lets the user assign the 
selected features to any combination of Zone, Branch, Division, or 
Sector.  The form allows the user to control which of these levels is 
affected by checking or un-checking the checkbox for each level.  For 
example, the checkboxes let the user assign all the affected features to 
a different zone, while leaving the branch, division, and sector 
assignments unchanged.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The form contains a series of relate checkboxes and dropdown lists.  
Each pair represents a “level” at which the features can be assigned, 
(i.e., Zone, Branch, Division, or Sector).  Check the box for a particular 
level if you want to change that assignment for the selected features.  
Select the assignment from the corresponding dropdown list.  
Uncheck the box if you do not want to change the assignments at that 
level.  For example: 
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To reassign all the features to a particular zone, but keep the lower 
level assignments the same, check the zone box, uncheck the 
remaining boxes, and select a zone from the dropdown list.  
 
To change just the sector assignment for a feature, uncheck all but the 
sector box, and select a sector.  The feature(s) will remain in the same 
zone, branch, and division, but will be reassigned to a new sector. 
 
Press the OK button to apply the settings.   
 
Press the Cancel button to close the form without applying the 
settings.   

Get Latitude/Longitude 
 
Click this button to activate the tool, then click anywhere on the map 
display.  A message box will pop up showing you the latitude and 
longitude of the location where you clicked.  The coordinates will be 
formatted according to the preferred coordinate you specified in the 
Incident properties dialog, above. You can also select a different 
coordinate format by selecting from the pull down list activated from 
the drop down arrow on the dialog.  
 
You can also switch between NAD27 and WGS84 using the radio 
buttons on the form. (Please note that NAD83 and WGS84 are almost 
identical so NAD83 was left off). The Latitude/Longitude values will be 
automatically converted between the selected datums. 
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Group 3. Perimeter Tools 
 
 

Create Fire Perimeter 
 
This command allows the user to create a new fire perimeter polygon 
by drawing it on the map.  Users can activate the edit task by clicking 
this button, or by selecting the “Create Perimeter Polygon” task from 
the edit task list, then selecting the perimeter layer as the target layer.   
 
The fire perimeter polygon can be created using any ArcMap edit 
sketch tools.  When the polygon is completed, a pop-up form is 
displayed that lets the user enter attributes for the new fire polygon 
feature. The standard attributes for fire perimeter polygons include the 
“Label” field, which is a general-purpose, optional field. The label field 
can be used to store text used for labeling or any other documentation 
purposes. Other free form attributes include the “Unit ID”, and the 
“Burn Code”. These fields are used specifically by certain 
organizations that participated in the development of the FIMT tools 
and may not be required by all users. The form also includes pull 
down lists for the fields: “Fire Class”, and “Burn Class”.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Fire Perimeter Attributes form contains a button that let the user 
assign the perimeter to an organizational unit. These organizational 
units are set in the same manner as the “Assign to Units” command 
documented in the Group 2 tools. The “Assign to Units” button is 
available whenever a fire perimeter, line or point feature is created. 
(See “Assign to Units” at the end of this appendix for more 
information). 
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The Fire Perimeter Attributes form contains another button that lets 
the user enter feature-level metadata describing the source of the fire 
perimeter polygon feature and the date and time it was collected (See 
“Feature Level Metadata” at the end of this appendix).   Both the unit 
assignment data and the feature-level metadata are optional as far as 
the application is concerned. 

 
Every time a fire perimeter feature is created, a corresponding “sector 
line” feature is also created.  The Sector lines are stored in the 
Incident PerimeterSector feature class. The sector line feature is used 
to manage the assignment of portions of the perimeter to different 
operational units.  The management of the sector lines contained in 
the PerimeterSector feature class is transparent to the user. The user 
should not any direct editing interaction with lines in the 
PerimeterSector feature class except splitting the lines into two or 
more pieces.  In fact, the FIMT Fire Mapping Tools application is 
designed to prevent the user from changing the geometry of a sector 
line if it is associated with a perimeter polygon.  The application also 
synchronizes the shape of the sector line with changes to the shape of 
the perimeter polygon, so it remains coincident in spite of moving, 
modifying, or reshaping the perimeter polygon.  
 

Copy to Perimeter Layer 
 
This tool copies any polygons selected in other map layers into the 
perimeter layer.  You can use this tool to copy perimeter boundaries 
from a shapefile or any other feature source.  The tool becomes 
enabled when you are in an edit session, the perimeter layers are in 
your map, and you have at least one feature selected.   It will only 
copy polygon features – it will ignore lines and point features if they 
are selected. 

Change Perimeter 
 
This command is used to modify the attributes (“Label”, “Unit_ID”, 
“Fire_Class”, “Burn_Code”, “Burn_Class”, Assignment, or metadata) 
for the currently selected perimeter polygon.  It pops up the same form 
that is used to set the perimeter attributes, assignments, and 
metadata when a new fire perimeter polygon feature is created.   
 

Split Assignment Line 
 
This tool is used to split the FirePolygon into units for assignment to 
Zone, Branch, Division, and Sector code if appropriate. The tool 
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operates by drawing a line across an existing FirePolygon using the 
“knife icon. At the point the split line intersects the FirePolygon, 
temporary Blue and Green PerimeterSector lines are drawn to 
indicate the location or side to receive the assignment attributes. The 
following dialog appears that is used to make the appropriate 
assignments. Once the assignments are made, and OK is clicked, the 
temporary graphics are removed. Once a split is completed the tool 
will automatically generate the appropriate AssignmentBreak 
symbology at split. 
 
 
 
 
 
 
 
 
 
 
 
 

Update Perimeter Assignment Breaks 
 
This command runs as both a background process that listens for 
changes to perimeter polygons, perimeter assignment (sector) lines, 
or perimeter assignment break points and as an interactive process. 
When used interactively, it regenerates the point features used to 
represent breaks in assignments of sections of a perimeter boundary. 
 
Background process operations:  
 
If a perimeter polygon moves or has its shape changed, the command 
resynchronizes the PerimeterSector feature class lines to keep them 
coincident with the FirePolygon polygon(s), and regenerates the break 
points between perimeter assignments.  
 
If a sector line moves and it is associated with a FirePolygon polygon, 
the command restores the original geometry of the feature preventing 
the user from undoing the coincidence between the PerimeterSector 
line and the FirePolygon polygon.  
 
If an AssignmentBreak point moves, the command restores the 
original geometry of the point preventing the user from moving the 
point off the perimeter boundary.  
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NOTE:  Users can create PerimeterSector lines and/or 
AssignmentBreak points that are not associated with a FirePolygon 
polygon by simply creating features in these classes.  Those features 
will not be affected by this command.  
 
Interactive Process operations: 
 
The user may modify the assignments of the PerimeterSector lines 
associated with a FirePolygon polygon by selecting them and using 
the “Assign to Unit” command, by editing the attributes directly, or 
other means in ArcMap.  When manual edits are performed, the 
AssignmentBreak points between unit assignments may no longer be 
accurate.  When the button is clicked, ArcMap will re-evaluate the 
junctions between all PerimeterSector lines, merge any adjacent lines 
that have the same assignments breaks, regenerate break points at 
the new line ends, and set the rotation angle of those points to match 
the orientation of the lines.   Perimeter lines and break points the user 
has added directly that are not associated with a perimeter polygon 
are not affected by this command.   
 

Create Island 
 
This tool is used to create island or (donut) polygons inside an existing 
FirePolygon. The tool activates the FIMT Create Island edit task on 
the FirePolygon target feature class. No other ArcMap editing tools 
should be used to create island polygons. Due to the complexity of the 
relationships between FirePolygon, PerimeterSector, and 
AssignmentBreak feature classes, unpredictable behavior could be 
encountered.  
 
Once the Create Island tool is invoked, any valid ArcMap drawing tool 
can be used to create the actual geometry of the island. This included 
using the sketch tool or the trace tool to trace existing features 
selected in other layers. 

Remove Island 
 
This tool is used to remove island polygons from an existing 
FirePolygon. This tool is the only method that should be used to 
remove or delete island polygons. Do not use any other ArcMap 
methods. The tool operates by deleting all island geometry that are 
contained completely inside a temporary polygon drawn by the user. 
Draw a bounding box around the island you would like to remove.  
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An error message will be displayed if the polygon is drawn outside the 
outer boundary of the FirePolygon or if the island polygon intersects 
the polygon. 
 

Convert Perimeter to Line 
 
This command converts selected perimeter polygon(s) into a line and 
adds it to the editable line feature class of the user’s choice.  For 
example, it could be used to convert the selected fire perimeter into a 
Fire Line feature. The command pops up a list of all editable line 
layers in the current map document and lets the user select the target 
layer. The selected polygons are converted into polylines and written 
to the selected target featureclass. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Perimeter Report 
 
This button produces a text report containing the area of the fire, and 
the lengths assigned to the divisions and branches. This button is only 
enabled if Incident perimeter layers are present in the active data 
frame.   
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The Copy button on the Perimeter Report dialog is used to copy the 
text contents to your Windows clipboard. The text can then be pasted 
into other applications or pasted into a map layout. 
 

Perimeter Change Report 
 
This button produces a text report that displays a list of area, 
perimeter, etc. for perimeter polygons stored in the Incident’s history 
layers.  The report shows the change from each archived polygon to 
the next, so it is easy to see the rate of progression of the fire.  The 
report only looks at the features in the history layer, not the current 
perimeter layer.  Therefore, the report should be run immediately after 
archiving the perimeter polygon if possible, so that the current 
perimeter is included in the report.  The following message will prompt 
the user to archive the current fire polygon before producing the 
report. 
 

 
 
 
 
 

 
The History report contains the Date, Time, Acres, Hectares and the 
change Acres, and change hectares for the Hist_FirePolygon feature 
class.  
 
 
 
 
 
 
 
 
 
The Copy button on the History Report dialog is used to copy the text 
contents to your Windows clipboard. The text can then be pasted into 
other applications or pasted into a map layout. 

Draw History 
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This command draws the polygons from the perimeter history in 
reverse order, using a red color ramp, to show the progression of the 
fire on the map.  The reverse order results in the larger most current 
fire perimeter polygons being draw underneath the older smaller fire 
perimeter polygons. The button operates exclusively on the polygons 
from the fire perimeter history layer (Hist_FirePolygon feature class). 
The “Copy Incident to History” button should be used prior to drawing 
the history to insure that the most current perimeter is included in the 
display. 
 

Group 4. Fire Line Tools 
 
 

Create Fire Lines 
 
This button activates the Create Fire Line edit task and sets the 
Target layer to Fire Line. You can do these same steps using the 
standard ArcMap user interface by selecting the edit Task and Target 
layer.   
 
With the Create Fire Line edit task selected, you can create a new 
fire line using any of the standard ArcMap edit sketch tools, such as 
the sketch tool (pencil icon) for drawing free-form lines, the curve tool 
for drawing parametric curves, and any other drawing tools you have 
available.  When you complete the line by either double-clicking on its 
last point, or by right-clicking on the map display and selecting Finish 
Sketch, the Create Fire Line task pops up a dialog used to set the fire 
line’s type and other properties. 

 

Copy to Fire Lines 
 
This button lets you copy the selected line features from another layer 
into the Fire Line layer.  For example, you may have a layer containing 
streams or roads.  Select the features from that layer that you want to 
use as fire lines, and then click this button.  The selected features will 
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be added to the fire line layer and given a fire line type of 
Miscellaneous.  You can use the Change Fire Line Type control to 
set them to an appropriate type. Any attributes the imported lines have 
in common with the fire line feature class will also be copied. Lines 
copied from another incident will retain their type, etc. 
 
This control only copies line features.  Any selected polygon or point 
features are ignored. 
 

Change Fire Line 
 
This control lets you change the type of a fire line.  For example, you 
can change a proposed dozer line to a completed dozer line.  The 
control is activated if you are editing the Incident database, the fire line 
layer is present in the map display, and you have exactly one fire line 
selected.   
 
Click on the button, and the fire line type dialog is displayed: 
 
 
 
 
 
 
 
 
 
 

 
Select the new fire line type from the first dropdown list, and assign it 
to a division if you wish. 

Split Fire Line 
 
This tool lets you split a fire line into two separate lines.  You can then 
assign a different type to one or more of the new lines.   To use the 
tool you need to be editing the Incident geodatabase, and the fire lines 
layer must be present in the map display.   You do not need to have 
any features selected – If you do, the selection highlight will obscure 
the blue and green highlighting that is used to designate the two new 
fire lines resulting from the split.  
 
This control is a tool, just like the drawing tools or pan and zoom tools.  
You activate it by clicking on its icon and then use the tool to interact 
with the map display.  When you activate this tool, the cursor icon 
turns into a knife.  To split a Fire Line, click once on one side of the 
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split point.   Then, move the knife to the other side of the line, so the 
feedback line crosses the Fire Line at the point where you want to split 
it.  Click a second time.  The picture below shows a line split in 
progress: 
 
 
 
 
 
 
 
 
 
 
 
 
After you click the second time, the line will be split, and the two 
halves will be drawn in green and blue.  A dialog will open in which 
you can set the Fire Line types and division assignments for the blue 
and green sections: 

 

Join Fire Lines 
 
This control takes two adjacent fire lines and merges them to create a 
single fire line.  To activate the control, you must be editing the 
Incident database, the fire line layer must be present in the map, and 
you must have exactly two fire lines selected.   
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When you click on the tool, the two fire lines will be joined into a single 
line, and a dialog will pop up to let you set the type of the new fire line: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the fire line type from the drop-down list, and assign it to a 
division if you wish. Input the Label field value, and the line width if 
desired.  Click OK to replace the two original fire lines with the new 
merged one. 

Fire Line Report 
 

Click this button to get a brief report listing the lengths of various fire 
lines. This report can be saved to a file or copy and pasted into a text 
document.  Below is an example of the fire line report. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 63



 
 
 
The Copy button on the Fire Line Report dialog is used to copy the 
text contents to your Windows clipboard. The text can then be pasted 
into other applications or pasted into a map layout. 
 

Group 5. Fire Point Tools 
 
 

Create Fire Point 
 
This button activates the Create New Fire Point edit Task and sets 
the Target layer to Fire Point with an “Unknown” type attribute.  You 
can do these same steps using the standard ArcMap user interface by 
selecting the edit Task and Target layer.  This control is just a shortcut 
to simplify the process.   
 
With the Create New Fire Point edit Task selected, you can create a 
new fire point using any of the standard ArcMap edit sketch tools, 
such as the standard sketch tool that lets you click to make a new 
point, or any other point input tool.  When you enter the new point 
location, the Create New Fire Point task will pop up this dialog to 
allow you to set the point’s type and other properties.  Depending on 
the point type, you may be asked for just a Label value and Name, or 
you may be asked for additional information, such as date, time, and 
direction: 
 

 
 

 

Create Fire Point by Latitude/Longitude 
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This tool lets you create a new fire point by entering a latitude and 
longitude.  When you click this button, an input dialog will be displayed 
in which you enter the coordinates of the point. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Use the radio buttons in the lower part of the dialog to specify the format in 
which you want to enter the latitude and longitude of the new point.  The 
format you set for the Incident, either at the time it was created, or if you 
modified it using the Incident Information tool described earlier, will be 
selected by default.   

• If you override the default format, the change will be only temporary.  This 
allows you to make an entry using something other than the default format 
on a one-time basis.  

• Use the radio buttons in the Datum control panel to specify the choice of 
datum’s used for data input. The valid choices are WGS84 and NAD27. 

• Enter the latitude and longitude of the new point, and click the OK button.  
 

The tool will create the new point, and then display the fire point type 
dialog that allows you to specify the point type and other information about 
it.  This is the same dialog that is used if you click on the map to create the 
new point, as described in the previous tool: 
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Copy to Fire Points 
 
This button lets you copy the selected line features from another point 
layer into the Fire Point layer.  For example, you may want to copy 
features from a layer of fire hydrants or other water sources into the 
FirePoint layer.  Select the point features in the other layer that you 
want to copy to the FirePoint layer, and then click this button.  The 
selected features will be added to the FirePoint layer and given a fire 
point type of Miscellaneous.  You can use the Change Point 
Information control to set them to an appropriate type.  Points copied 
from another incident of points that have matching attributes will retain 
their original attribute values. 
 
This control only copies point features.  Any selected polygon or line 
features are ignored.  

 

Move Fire Point to Latitude/Longitude 
 
This control lets you move the selected fire point to a specific latitude 
and longitude.  You might use this to move a point whose location was 
originally estimated from the map, for which GPS coordinates are now 
available.   The control is enabled when you are editing the Incident 
geodatabase, the Fire Point layer is present in the map, and you have 
exactly one fire point selected.   
 
When you click the button, the control will display the 
latitude/longitude input dialog shown below.  This is the same dialog 
that is used by the Create New Fire Point: Latitude/Longitude 
Coordinate Input tool that was described previously, except that in 
this case, the current latitude and longitude of the fire point are 
displayed in the dialog. Simply type in a new latitude/longitude and 
click OK. 
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Change Fire Point  
 
This control lets you change a fire point from one type to another.  You 
would use this tool to change a staging area into a camp, for example.  
The control is enabled when you are editing the Incident database, the 
Fire Point layer is present in the map display, and you have exactly 
one fire point selected.  When you click this button, it displays the fire 
point type dialog.  This is the same dialog that is used when you 
Create New Fire Point, as described previously. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ancillary utilities used by FIMT Fire Mapping tools 

Unit Assignment 
 
This button is available on the dialogs opened when a new fire 
perimeter, line, or point is created. This dialog is used to initially 
assign the appropriate units to new features. 
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Feature Level Metadata Form 
 

This button is available on the dialogs opened when a new fire 
perimeter, line, or point is created. The attributes collected on the 
Feature-Level Metadata form are written to the new features 
associated feature class. Select the appropriate attributes value from 
the pull-down list. 
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Appendix II: FIMT Quick Reference Guide 
 

Create Incident
Open Existing Incident
Switch Incidents
Edit Incident

                  Incident InformationArcG
IS

 - FIM
T Q

uick R
eference G
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Copy Incident to History 
Copy Incident Layers to Data 
FExport Incident to Shape Files
Auto-Update Measures
Update Fire Names and Numbers
FIMT Feature Metadata
Incident Symbols

                  Label Multiple Fields 

Assign to Unit
Get Latitude/Longitude
Create Fire Polygon
Copy to Perimeter Layer
Change Perimeter
Split Assignment Line

                   

                  Update Perimeter Assignment  

Create Island
Remove Island
Convert Perimeter to Line
Perimeter Report
Perimeter Change Report
Draw History
Create Firelines
Copy to Firelines
Change Firelines
Split Fireline
Join Firelines
Fireline Report
Create Firepoint
Create Firepoint by Lat/Lon
Copy to Firepoints 
Move Firepoint to Lat/Lon

                  Change Firepoint 

 69



Appendix III CalcLoadingParams 
 
This tool is very easy to use for determining the X/Y domain and precision, but 
only when your data is not tiled.  The tool installs with the FIMT install and can be 
found under: 
 

Start> Programs> FIMT> Calc Loading Parameters 
 
Step 1: Click on the Data (…) 
button to browse for the 
coverage/shape file you intend to 
load.  This data must be in the 
coordinate system you intend to 
use in the Geodatabase.  Choose 
a value for map units if not 
defined by the data source. 

1

2

3

 
Step 2: Test various values for 
Precision (2), increase the 
number while watching the 
allowable space indicator.  As the 
precision value is increased, the 
amount of allowable space 
decreases. 
 
Step 3: The Data loading 
parameters are calculated and appear in the lower left-hand corner (3).  
IMPORTANT:  Record these numbers to use when setting a custom spatial 
reference. 

 
IMPORTANT:  Selecting Spatial Extent 
 
The extent can only be set when first creating the Incident database.  If you later 
need to include data that falls outside of the original extent of the dataset, you 
must delete the entire feature dataset, recreate it with a larger extent and reload 
all of the data. ESRI recommends a precision value equivalent to +/- 1 mm 
(precision = 1000) for data from the most accurate spatial data, a survey with 
theodolite.   

 
Set Map Units & accuracy: choose Centered to allow for expansion. 

 
Write down “Precision” value e.g. 1000.   

  
IMPORTANT:  Precision reflects data quality 

 
The precision you choose when creating a new feature class should reflect the 
quality of the source coordinate data. Higher-resolution data requires a higher 
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precision value to preserve all of the known information recorded in the floating-
point coordinate values. 
 
Not all digits in a floating-point number represent actual data, though. A data 
capture device, such as a scanner, may be able to resolve coordinate locations 
within one foot when reading a 1:20,000 scale map. But on the scanned paper 
map, the pen used to draw a line representing a river may cover 40 feet on the 
ground. As a result, the computer would end up storing 40 times more data than 
is necessary to represent the actual information contained in the map. When 
converting that data to an ArcSDE feature class, you could intentionally shed 
some unnecessary digits from the floating point values in order to save space 
and improve performance. 
 
Be aware that it is impossible for the computer to determine the quality of your 
data for you. For example, you may purchase an economical global positioning 
system (GPS) at most sporting supply stores. You could read the display on your 
GPS receiver and determine that your office is located at –120.4832765 degrees 
longitude and +34.5912634 degrees latitude. But, those values may only be 
accurate to four decimal places, not the seven displayed on the receiver. You 
could create a feature class with a precision of only 10,000 and still preserve all 
of the true information collected by your GPS receiver. 
 
Without input from you, the ArcSDE software or a client application will calculate 
the largest precision possible for a given dataset, approximately, in order to 
preserve the most information from the source floating point numbers. This will 
result in unnecessarily large storage requirements and, as a result, decreased 
server performance. Information regarding data quality should accompany any 
data source, either digitally or as supporting hard-copy documentation. Without 
this metadata, neither you nor ArcSDE can choose an appropriate precision for a 
feature class which will store that data.  You can use the CalcLoadingParams 
tool to try out various precisions and gain a better “feel” for the value. 

 
For Example: 

 
Data 

collection 
method 

Measurement 
units 

Equipment 
precision 

Minimum feature class 
precision 

ESRI Recommended feature class 
precision 

Digitize 
1:250,000 
map Feet +/- 416 ft 1 (one foot) 1 (one foot) 

Professional 
GPS Meters +/- 0.5 m 2 (one half meter) 10 (one tenth meter 

Survey with 
theodolite Meters +/- 0.005 m 200 (five millimeters 1000 (one millimeter) 
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Appendix IV: Incident PGDB Data Model 
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